
 

elcome to Extensis Suitcase 9!
Suitcase 9 continues to provide speed, stability and compatibility with current operating systems. 
Systems run faster and crash less when fonts are managed and activated only when they are needed. 
Suitcase 9 also provides powerful font previews, so no matter how you prefer to see your fonts, 
Suitcase can help you make the right font selection. The new features in Suitcase 9 make it easier than
ever to preview, activate and use your fonts. That means you can spend less time worrying about 
making fonts work right and more time using them creatively.
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1. System Requirements
A Power Macintosh or equivalent.
Mac OS 8.5 through Mac OS 9.
32 MB of RAM with Virtual Memory set to 1 MB above.
The Suitcase 9 XT for QuarkXPress requires QuarkXPress 4.0.3 or higher.
Suitcase 9 requires Adobe Type Manager version 4.5 or higher in order to render Type 1 fonts.
_______________________________________________________________
2. Contacting Extensis
To reach us for technical support or general questions, please use one of the following methods:

Extensis Products Group
1800 SW First Avenue
Suite 500
Portland, OR 97201
(503) 274-7030
(503) 274-0530 (fax)
Email: support@extensis.com
Web: http://www.extensis.com

Extensis UK
Unit 3, Bouverie Court
The Lakes
Northampton, NN4 7 YD
United Kingdom
Telephone: +44 (0) 16 04 636300
Fax: +44 (0) 16 04 636366
E-mail: info@extensis.co.uk

Our web site includes a detailed, up-to-date FAQ/troubleshooting page for Suitcase 9. If you have 
troubleshooting or functionality questions, please visit http://www.extensis.com, contact Extensis 
technical support or visit the Suitcase Forums at http://www.extensis.com.
_______________________________________________________________
3. What’s New in Suitcase 9.0.1
Lots of speed improvements, bug fixes and a new feature!



- Adding fonts to Suitcase 9 is now significantly faster.
- The Suitcase 9 FontEngine now has a much smaller memory requirement.
- Bug fix for a Suitcase 9 and CarbonLib 1.0.4 conflict that caused the Suitcase FontEngine to crash.
- Bug fix for users running Mac OS 9. Fonts activated with Suitcase 9 will now show up immediately in 
applications that are already open.
- We’ve added a new feature which allows you to view your fonts by font suitcase or by individual font 
faces. You’ll find this new feature under the View menu.

By default, the view will be set to View by Suitcase. To toggle between Font view or Suitcase view, 
simply press Command-E or select View by Font or View by Suitcase from the View menu.

When you are in View by Suitcase mode, you can “twist” open your font suitcases to see the contents 
of each suitcase.

_______________________________________________________________
4. Installation Notes
The installer will place the Suitcase 9 application, online help and other supporting files into an 
Extensis Suitcase 9 folder on the volume chosen during installation.

Suitcase 9 XT is installed into the QuarkXPress XTensions folder. In the event you have multiple copies 
of QuarkXPress, you will be asked which of copy of QuarkXPress you wish to use the Suitcase 9 XT with.
If you wish to use the Suitcase 9 XT with multiple copies of QuarkXPress, you will need to place a copy 
of the Suitcase 9 XT into the QuarkXPress XTensions folder of each copy of QuarkXPress you want to 
use the Suitcase 9 XT with.

The following files are installed into your active System Folder.
Extensions:
- Suitcase 9 Extension
- Suitcase 9 FontEngine
- Suitcase FontEngine Lib

Control Panels:
- Suitcase 9 MenuFonts

Apple Menu Items Folder:
- Extensis Suitcase 9 application alias
_______________________________________________________________
5. Other Font Management Software
It is recommended that you do not use other font managers when managing fonts with Suitcase. The 
following products can interfere with Suitcase 9 products and are moved during installation.

- Previous versions of Suitcase
- Previous version of MenuFonts
- Action WYSIWYG Menus
- Dave’s Software FastFont Menu
- Adobe Type Reunion
- Adobe Type Reunion Deluxe
- Impossible Software TypeTamer
- Alsoft MasterJuggler
- Diamondsoft Font Reserve
- Diamondsoft Font Reserve XTension
- NRG Software FontFetch XTensions

Adobe Type Manager Deluxe
Extensis recommends replacing ATM Deluxe with a regular (Light) version of ATM when using Suitcase 
9. Users who remove Adobe Type Manager Deluxe will need to install the regular version of ATM to 
keep the font smoothing feature found in ATM Deluxe.



For Mac OS 8.5 or 8.6 users, a copy of ATM can be found on the Adobe website or on a Mac OS 8.5 or 
Mac OS 8.6 CD.
For Mac OS 9 users, you will need to use ATM Light version 4.5.2 or higher. ATM Light can be found on 
the Adobe website or on the Extensis CD that contains Suitcase 9.
_______________________________________________________________
6. Serializing and Registering Suitcase
After launching Suitcase 9, you will be prompted to serialize and register the software. Please enter the
serial number located inside the product packaging. If you do not have a serial number, you can 
choose to run Suitcase in demo mode, which allows full functionality for 30 days.

Please register using one of the built-in electronic registration methods. If you do not have Internet 
access, a modem, fax/modem, or printer, you may fill out the registration card in your Suitcase 9 
packaging.

Please note: Microtek scanners may interfere with the built-in electronic registration process. If you are
using a Microtek scanner, please turn it off before attempting to register Suitcase 9. You may turn the 
scanner back on once the registration process is complete.
_______________________________________________________________
7. Online help
An HTML version of the Suitcase, Suitcase XT and Suitcase MenuFonts documentation can be accessed
from within the Suitcase application by choosing Suitcase 9 Help from the Help menu. This will launch 
your default web browser application and open the Suitcase online help pages.

You can also find help and answers to Frequently Asked Questions on the Extensis web site:
http://www.extensis.com/support/
_______________________________________________________________
8. Known Software Issues/Compatibility
Suitcase 9 MenuFonts
- In order for Suitcase 9 MenuFonts to work properly with Microsoft Word, you will need to disable 
Word’s own WYSIWYG menu function. To do so, select Preferences from the Tools menu. Next, on the 
General tab, uncheck the “WYSIWYG font and style menus” check box.
- Suitcase 9 MenuFonts will not work with Microsoft Excel, Microsoft Powerpoint or Tex-Edit.
- Suitcase 9 MenuFonts will not alter font menus to match Kaleidoscope-altered menus.
- Adobe Illustrator 7 and 8, Photoshop 5 or higher, InDesign, Acrobat 4.0 and Pagemaker 6.5 have their 
own built-in font menu features. These applications will use the Factory Default font menus.

Suitcase 9 XT
- The Suitcase 9 XT is not compatible with any version of QuarkXPress lower than 4.0.3.
- In some instances when the “Enable FontSync Support” pref is checked, the Suitcase 9 XT may 
indicate that a font is not an exact match when in fact it is. In these cases, Suitcase 9 XT rates the font 
as a “17 out of 20”.

Corrupt Fonts
Apple has released Font Manager Update 1.0, which fixes problems in the Mac OS 8.6 Font Manager 
that would corrupt some fonts, causing problems in Suitcase as well as other applications. It can be 
downloaded from Apple’s web site at: http://asu.info.apple.com/swupdates.nsf/artnum/n11489

Suitcase Server
- You cannot download fonts from a Windows Suitcase Server if the Windows directory has a name 
longer than 31 characters.
- When attempting to connect to a Suitcase Server with a large number of fonts (approximately 5,000) 
it is possible for the Suitcase Server Administration Application to run out of memory. To solve this 
problem, quit the Admin App and increase it’s memory partition approximately 1MB for every 1,000 
fonts that you wish to download.

Suitcase 9
- The Suitcase 9 FontEngine conflicts with the BootX Extension 1.2. With the BootX Extension installed, 
the Suitcase FontEngine will not function. Any fonts that you have set to be open at startup will not be 



opened.
- Suitcase 9 will not decompress Suitcase 3 fonts. If you attempt to add fonts that were compressed by 
Suitcase 3, Suitcase 9 will crash.
- Linking a printer font to an orphan screen font does not update the font’s preview until after restart.
- When using Adobe Type Reunion or Action WYSIWYG with Suitcase 9, fonts opened in Suitcase 9 do 
not always appear in applications immediately.
- Via AppleScript, you can create more than one set with the same name.
- ATM may run out of memory while previewing deactivated fonts. Set ATM’s memory to 2 MB if you 
encounter this problem.
- If you have two identical screen fonts in the Suitcase database, the previews are the same for both 
fonts even if one of them is an orphan screen font.
- Via Apple Script, you can add more than one set with the same name.
- Suitcase will not permanently activate fonts that are located on a remote volume. This does not relate
to fonts that have been downloaded from a Suitcase Server.
- Dragging fonts over a Server Set will cause the Server Set to highlight indicating that you can add 
fonts to a Server Set. Only via the Suitcase Server Administrator application can you add fonts to a 
Server Set.
- Applications in the Startup Items folder that have a corresponding Application Set in Suitcase will not 
activate fonts when they launch.
- The “Up-to-date” server message gives you the time when you began synchronization, not the time it
finished.
- If the font Chicago is in a set with other fonts and the same Chicago font is in your System Fonts 
folder, the set may not completely activate. To solve this, remove Chicago font from the set and leave 
it in your System Fonts folder.

Database Converter
- In order for the Suitcase Database Converter to work properly, you MUST RESTART YOUR COMPUTER 
after running the Suitcase 9 installer.    Running the Converter before restarting will result in a failure to
create a Suitcase 9 Font Database.
- SimpleText application sets that are added via the Database Converter do not work properly. You will 
need to manually recreate any SimpleText application sets if you are upgrading from Suitcase 8.x.
- If you run the Database Converter twice, you will see duplicate sets in Suitcase 9.
_______________________________________________________________
9. Troubleshooting
In order for ATM to properly draw and print PostScript Type 1 fonts, both the PostScript outline file and 
the font suitcase must be located in the same folder.

Some applications (e.g., Adobe Illustrator, Adobe PageMaker and QuarkXPress) update their font 
menus dynamically when you activate fonts. Other applications (e.g., Keycaps, Microsoft Excel and 
Microsoft Word) need to be relaunched in order for the newly activated fonts to appear in the font 
menu.

In order for MenuFonts to display PostScript fonts properly in menus, the ~ATM control panel must load
before the ~Suitcase 8 MenuFonts™ control panel.    If ATM doesn’t load before MenuFonts, or if font 
rasterizing is turned off within the ATM control panel, PostScript fonts will appear bitmapped or will not 
be visible at all in MenuFonts menus.

Before selecting a font as the Desktop font (Appearance control panel), you must first copy the font 
files to the Fonts folder in the System Folder.

In order to run Adobe Acrobat, the fonts Adobe Sans MM, Adobe Serif MM, Symbol and Zapf Dingbats 
must be present in the System Folder’s Fonts folder. Acrobat 4 will allow these fonts to be placed in a 
folder with the application. More information on how fonts are used with Acrobat can be found at the 
following web address:
(http://www.adobe.com/supportservice/custsupport/SOLUTIONS/topissuesacr.htm)

The Mac OS limits the number of files that can be open at one time. To help you stay within this limit, 
Suitcase 9 will limit the number of fonts that you can have open at one time. The open file limit varies 



depending on which Mac OS you are running.
_______________________________________________________________
10. Version History
Suitcase 9.0 - Initial release of Suitcase 9 and Suitcase 9 XT.
Suitcase 9.0.1 - Addition of the “View by Suitcase” feature, performance enhancements and bug fixes.
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